# Revision History

<table>
<thead>
<tr>
<th>Revision Number</th>
<th>Revision Summary</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>- 00</td>
<td>Original release.</td>
<td>11/02/2009</td>
</tr>
<tr>
<td></td>
<td>Update web address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Update Dukane Contacts page.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Update Regulatory Compliance information.</td>
<td>07/20/2010</td>
</tr>
</tbody>
</table>
This page intentionally left blank
## Contents

**Section 1 - Introduction** ................................. 1

**Section 2 - System Requirements** ....................... 5

**Section 3 - Installation** ................................. 15

**Section 4 - Operation** ................................. 23

**Section 5 - Multiple Welder Connections** .............. 45

**Section 6 - Contacting Dukane** ......................... 53

**Section 7 - Appendices** ................................. 57

  A - List of Figures ........................................ 59
  B - List of Tables ........................................ 60
  C - Regulatory Agency Compliance ........................ 61

**Index** .................................................. 63
This page intentionally left blank
SECTION 1

Introduction

General User Information .......................... 3
  Read The Manual First .......................... 3
  Notes, Cautions and Warnings .................. 3
  Drawings and Tables ............................ 3

*iQ Explorer* Overview .......................... 4

Key Features ................................. 4
This page intentionally left blank
General User Information

Read This Manual First
Before operating your software, read this User’s Manual to become familiar with it. The manual is organized to allow you to learn how to effectively operate this program. Examples given are chosen for their simplicity to illustrate basic operation concepts.

Notes, Cautions and Warnings
Throughout this manual we use NOTES to provide information that is important for the successful application and understanding of the product. A NOTE block is shown to the right.
In addition, we use special notices to make you aware of safety considerations. These are the CAUTION and WARNING blocks as shown here. They represent increasing levels of important information. These statements help you to identify and avoid hazards and recognize the consequences. One of three different symbols also accompany the CAUTION and WARNING blocks to indicate whether the notice pertains to a condition or practice, an electrical safety issue or a operator protection issue.

Drawings and Tables
The figures and tables are identified by the section number followed by a sequence number. The sequence number begins with one in each section. The figures and tables are numbered separately. The figures use Arabic sequence numbers (e.g. –1, –2, –3) while the tables use roman sequence numerals (e.g. –I, –II, –III). As an example, Figure 3–2 would be the second illustration in section three while Table 3–II would be the second table in section three.
**iQ Explorer Overview**

This program enhances any compatible *iQ Series* ultrasonic generator through a user interface that allows monitoring and setup to be done virtually anywhere. Whether installed on your desktop or laptop PC, this tool gives more flexibility and control for the processes you manage.

**Key Features**

**iQ Explorer User Interface**

- **Windows operating system** - Familiar file folder menu structure, requiring no special training.
- **Touch screen input** - Makes programming easier. All welder setup parameters are programmed from one menu page. (Currently, availability is limited for use with the *iQ* HMI or PCs with touch screen, such as tablets.)
- **Ethernet connectivity** - For connection to local area network or stand-alone applications.
- **Supervisory password** - Control feature for locking out system controls.
- **Remote connectivity** - Dukane hotline is available for system diagnostics and troubleshooting 24-hours a day. (VPN access to the welder’s network is required. Consult with your IT staff about availability.)
- **One screen process settings page** - Last weld data displayed simplifies programming.
- **F1 Help command** - Instantly displays explanation of function.
- **iQ Explorer GUI** - In most cases, operation is independent of the generator, and removal or malfunction of the *iQ Explorer* does not affect machine functionality. (The *iQ* Servo Press DOES require *iQ Explorer* interface.)
- **Eight user-selectable graph parameters** - Velocity, energy, power, distance, amplitude, frequency, force and pressure for viewing and storage of each weld.
- **Production analysis screen** - Displays eight-hour shift production statistics: good, bad, suspect quantities and percentages.
- **Advance stack diagnostics** - Includes power and frequency graphs for stack (horn) documentation and future reference for troubleshooting.
SECTION 2

System Requirements

Computer Requirements .......................... 7
  Processor ............................................ 7
  Memory ............................................. 7
  Video Display ...................................... 7
  CD–ROM Drive .................................... 9
  Hard Disk Space .................................. 9
  Communication Ports ............................ 9

Software Requirements ........................... 10
  Windows™ ......................................... 10
  .NET Framework .................................. 13
  iQ System Requirements ........................ 13
This page intentionally left blank
Computer Requirements

*iQ Explorer* software requires the minimum computer hardware configuration mentioned below.

**Processor**

A IBM–compatible computer - desktop or laptop is required. The processor must have a clock speed of at least 800 MHz to operate. A faster processor with a more advanced architecture will provide improved performance.

**Memory**

At least 512 MB of RAM are required. Less memory will result in an unacceptable performance penalty. 1024 MB of memory or more will enhance the system response.

**Video Display**

A color display with at least 800 x 600 resolution and 256 colors (8-bit) is required (SVGA). Higher resolution and/or more colors will improve display characteristics. To determine your settings, click on the Start menu, as shown in Figure 2-1. Then select Control Panel as shown.

Your system may be capable of higher resolution and/or more colors. You may increase these settings to your preference. When you are finished, click the OK button, and then close the Control Panel window.

**TIP –**

The minimum requirements are not the same as the suggested configuration (800MHz processor with 512 MB of RAM). Just as we have a Minimum Daily Requirement of vitamins and calories, no one tries to live on 600 calories per day.
In the Control Panel window, double-click the Display icon. See Figure 2-2 below.

![Control Panel Window](image)

**Figure 2-2** Select Display from Control Panel Window (Windows XP)

A new popup window appears showing your current display properties. Click the Settings tab to view your current settings. Use the slider in the lower left corner of the window to adjust the display to at least 800 x 600. The drop-down menu in the lower right indicates the current color palette. Select at least 256 colors (8-bit). See Figure 2-3 below.

![Display Properties Window](image)

**Figure 2-3** Setting Display Colors and Resolution (Windows XP)
CD-ROM Drive
A CD-ROM drive is required to install the *iQ Explorer* software.

Hard Disk Space
The *iQ Explorer* software requires approximately 18MB of hard disk space for installation.

Communication Ports

USB Port
At least 1 USB port is required for the *iQ Explorer* installation. The port will be used by the security key.

Ethernet Port
An ethernet port is required for the *iQ Explorer* installation.

Security Key
A USB security key is required. The driver for the key is installed when the *iQ Explorer* program installs on your computer.
Software Requirements

*iQ Explorer* software is only compatible with the Microsoft Windows operating system.

**Windows®**

The computer operating system (OS) must be Microsoft Windows 98, Windows 2000, Windows XP, or Windows Vista. *See more information about Windows Vista on Page 12.* To determine which version of Windows you have, select **My Computer** in the Windows **Start** menu as shown in Figure 2-4.

**Windows XP**

Select **View System Information** as shown in Figure 2-5 below.

For earlier versions of Windows, open **Windows Explorer**, right click on **My Computer** in the screen and select **Properties**.

**Figure 2-4** Selecting My Computer (Windows XP)

**Figure 2-5** Selecting View System Information (Windows XP and earlier)
After selecting **View System Information** a new popup window will appear (See Figure 2-6) showing:

- Version of Windows™ currently installed,
- Type of processor used, and
- Amount of memory installed.

![Figure 2-6 Checking Operating System Version (Windows XP)]
Windows Vista Operating System

When running Windows Vista, before *iQ Explorer* can be run:

- Disable User Account Control (UAC) by following the instructions shown below.

Open up Control Panel, and type **UAC** into the search box. You’ll see a link for “Turn User Account Control (UAC) on or off”:

![Figure 2-7 Disable User Account Control - I (Vista)](image)

On the next screen you should uncheck the box for “Use User Account Control (UAC)”, and then click on the OK button.

![Figure 2-8 Disable User Account Control - II (Vista)](image)

You’ll need to reboot your computer before the changes take effect, but you should be all done with annoying prompts.

**NOTE**

The instructions relating to Windows Vista can be found at: [www.howtogeek.com](http://www.howtogeek.com) - search for - How to disable user account control.
.NET Framework
Microsoft .NET Framework 1.1 is required for running iQ Explorer.

iQ System Requirements
iQ Explorer is designed to compliment the iQ Series generators - the advanced models only. The software allows the operator to program these generators more easily and in less time than if programmed manually.

If there is any question about your generator type or its compatibility with iQ Explorer, please contact Dukane.
SECTION 3

Installation

Unpacking ......................................................... 17
Installing ......................................................... 17
  Choose a Configuration ........................................ 18
  Launching the Software ........................................ 21
Unpacking

Carefully open your shipping container, and make sure it contains the items shown on the shipping documents. Inspect all items, and report any missing items or damage immediately.

**iQ Explorer** Kit (Dukane Part No. 438-959) Contents:

<table>
<thead>
<tr>
<th>Item</th>
<th>Dukane Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD</td>
<td>437-00245</td>
</tr>
<tr>
<td>Security Key</td>
<td>433-37</td>
</tr>
<tr>
<td>Ethernet Patch Cable</td>
<td>200-1552-03M</td>
</tr>
<tr>
<td>User's Manual</td>
<td>403-579</td>
</tr>
</tbody>
</table>

Installing

(Microsoft Windows Operating System Only)

Step 1. Place the CD in the PC’s CD-ROM drive tray, and close the tray.

Step 2. The CD should start the installation process automatically.

(If this does not happen, go to START, then RUN and key in this command: d:\setup.exe [Where d: is your CD-ROM drive])

Step 3. The **iQ Explorer** installation window will appear. Follow the on-screen instructions to complete the installation, and remove the CD from the CD-ROM drive tray when finished.

Step 4. Insert the USB Security Key (Part No. 433-37) into any available USB port on the computer. *(This Security Key is also referred to as a dongle.)*

A **Found New Hardware Wizard** window will appear.

The Wizard detects a new USB device and searches for the appropriate software. When the Wizard completes its search a message will appear:

*The wizard has finished installing the software for: USB Dongle - Software Protection Device*

If you are prompted to search Windows Update for the driver, select **NO, not this time, and click Next.**

**NOTE**

Without the USB Security Key **iQ Explorer** will run for only a few minutes. The time and date bar at the bottom of the window flashes red if the key is not installed.

Step 5. Select **Install the Software Automatically** (Recommended) and click **Next**.

Step 6. Click **Finish** to end the **Found New Hardware Wizard**.

Step 7. Do not start **iQ Explorer** at this time.

**NOTE**

The software checks to see if Microsoft .NET Framework is installed. If it is not, put the iQ Explorer CD back into the CD-ROM drive tray, and close it.

Go to START, then RUN and key in: d:\dotnetfx.exe [Where d: is your CD-ROM drive] to install the .NET Framework.

After .NET Framework is installed, restart the computer, and complete the **iQ Explorer** installation.

Figure 3-1  Installation Start-up Screen
Choose a Configuration
Before continuing with the installation, set up the type of configuration you will use:

- PC directly connected to a single generator, **or**
- Each PC and generator connected as a node on a local area network (LAN).

**PC Directly Connected to a Single Generator**

1. Set the IP address on the PC that runs **iQ Explorer**.
2. Open Network Connections in the Windows Control Panel. The window should be similar to the one shown below. Right-click on Local Area Connection, and select Properties.

![Network Connections Window](image)

**Figure 3-2 Network Connections Window**

3. In the Local Area Connections Properties window, pick Internet Protocol (TCP/IP), and click on Properties.

![Local Area Connection Properties](image)

**Figure 3-3 Local Area Connection Properties**
Choose a Configuration  

4. In the Internet Protocol (TCP/IP) Properties window, enter the following IP address: 169.254.0.10

5. Enter Subnet mask: 255.255.0.0.  
   See the Figure below.

   ![Internet Protocol (TCP/IP) Properties](image)

   **Figure 3-4** Internet Protocol (TCP/IP) Properties

6. Click OK, and close the Network window.
   
   *You may need to restart the computer before changes take effect.*

7. Run iQ Explorer.  
   Look at Registered Welders (see Figure 3-5), and press the + to open the list of Networked Welders.  
   See which welder is directly connected to your PC.  
   If none are discovered, a —— will be displayed.

   ![Dukane iQ Explorer](image)

   **Figure 3-5** Registered Welders List

---

**NOTE**  
At first connection, the generator will be assigned a default IP address of 169.254.0.2 if the user does not change the address.
Choose a Configuration

You may need to restart the computer before changes take effect.

8. Click OK, and close the Network window.

   If nothing is displayed in the Registered Welders list:
   - Check that the correct subnet was entered.
   - Check that the part of the IP address that is masked by the subnet is entered correctly.
   - Your firewall could be preventing communications. In that case, see the IT administrator for help.

9. If the generator’s name is displayed in the list, click that name, and you are ready to start configuring your generator.

Changing the Generator’s IP Address

10. If you need to change the IP address of the generator, right click on the IP address in the Registered Welders list. You will be prompted to confirm your intention to change the IP Address. Click the Yes button.

11. The next window will contain the identity of the selected generator. See Figure 3-6. Modify the IP address to one that IS in the subnet of your PC, and press OK. Again, you will be prompted to confirm that you want to change the IP Address. Click the Yes button.

12. The name of the generator will now be displayed in the list of Registered Welders. Click on the name.
   
   Wait for the upload of parameters, and you are ready to start configuring your generator.

NOTE

If the IP address is displayed without the welder name, then the initial connection could not acquire the welder name, indicating a weak connection. Press the Scan Network button to try acquiring the welder name.

Assign IP Address for 00:80:AB:00:01:63

- Use the following IP address: 172.16.7.17
- Using direct PC connection (169.254.0.2)

Figure 3-6 Assign IP Address
Launching the Software

Autoboot
In standard operation *iQ Explorer* will autoboot (automatically begin) after the PC has been started. Figure 3-7 illustrates how the screen will look on start-up.

![iQ Explorer Start-up Screen](image)

**Figure 3-7**  iQ Explorer Start-up Screen

**Click Icon**
You may prefer to launch *iQ Explorer* by double clicking the desktop icon.

**NOTE**
To change the autoboot feature, you may remove this program from your computer’s start-up sequence using these steps:
1. Click on the *Start* button.
2. Click on *All Programs*.
3. Click on the *Startup* file folder.
4. Highlight *iQ Explorer* and right click to activate a dropdown menu.
5. Select *Delete* from the drop down menu, and tap the Enter key. That deletes the shortcut that starts the program.
This page intentionally left blank
SECTION 4

Operation

Main Menu ................................................................. 25
   Top of Screen Drop Down Menu Items ..................... 25
Menu Icons ................................................................. 26
Making an Entry ......................................................... 28
Options ................................................................. 28
Basic Setup .............................................................. 30
Save and Retrieve Setup Files ................................. 42
Save and Retrieve Part Data ................................. 42
Save and Restore Graph Data ................................. 42
Using the Help System ........................................ 43
This page intentionally left blank
Main Menu
This section gives an overview of the main icons shown in the menu bars.

Top of Screen Drop-down Menu Items

- **File**
  - Select a welder.
  - Open Part Data or Graph Data files;
  - Setup Files - Start a new one, or save, copy or delete them.

- **Tools**
  - Scan the network - Get a quick overview of active welding operations.
  - Units - Choose Imperial or Metric.
  - Options - See the next part of this manual, Menu Icons, Page 26.
  - Select Welder Type - Choose either DPC or iQ.

- **Window**
  - Manage how windows appear on the desktop.
  - Select which window will be on top.

- **Help**
  - iQ Explorer Help - Get answers to questions about basic iQ Explorer functions.
  - About iQ Explorer - Get version and copyright information.

---

**Figure 4-1 Top Menu Bar**
Menu Icons

Ten icons just below the top menu bar represent frequently used routines. These are easily accessible at any time. In the pages that follow you will get an overview of their usefulness.

Figure 4-2 Main Menu Icons
Icon Detail

**Figure 4-3 Icon and Function**

- **New setup file** - Start here to make a new setup file.

- **Clicking saves current item** - Save your data frequently.

- **Select welder to activate** - Choose a welder to use.

- **Show last selected welder** - Display the last welder that was selected.

- **Print setup** - Print the settings for your reports.

- **Scan network** - See which welders are active in the network.

- **Options** - Make settings to enhance how the PC manages the welding process. (*See the next page for more detail on Options.*)

- **Keyboard keys** - *(Use when no regular keyboard is available.*) A simulated keyboard appears. Use the mouse to position the cursor on the key you want. Click to select. Letters appear in the preview panel. Click ENTER to place the text in the chosen entry box of the active window.

- **Numeric keys** - *(For use when no regular keypad is available.*) A simulated keypad appears. Use the mouse to position the cursor on the key you want. Click to select. Numbers appear in the preview panel. Click ENTER to place the numbers in the chosen entry box of the active window.

- **Exit** - Shuts down the *iQ Explorer* application.
Making an Entry

1. Use the mouse to place the cursor in a white entry box and click. This activates a flashing vertical bar and confirms the entry box choice.

2. Use the PC keyboard, or PC numeric keypad to complete the entry. (Or use the program’s keyboard keys, or the numeric keypad, activated with icon selection as explained on the previous page.)

3. Tap the ENTER key to confirm the entry.

4. Entries that can be made using the mouse can also be made using a touch screen.

Options

Options help you manage the welding process using the settings offered through the nine tabs shown in Figure 4-4 below.

NOTE
In addition to the flashing vertical bar, entry boxes may be filled with a flashing color.
## Options

Table 4-I shows what can be done with **Options**.

<table>
<thead>
<tr>
<th>Option</th>
<th>What the Operator Can Do with the Option</th>
</tr>
</thead>
</table>
| **Communications** | • Prompt when generator changes are made.  
• Connect automatically to welders when discovered. | • Interval - Production Tab refresh rate (seconds). |
| **Security** | • Enable security.  
• Enable auditing to support FDA 21 CFR Part 11. | • Add Supervisor, Setups and Operators.  
• Set Password.  
• Show keyboard on password entry. |
| **Shifts** | • Enable saving Part Data in shifts. | • Name the shift and enter times.  
• Enable shift(s). |
| **Force**  | • Enter Force instead of Pressure. | |
| **Files** | • Automatically save graph data to file.* | • Directories to save graph data to file.* |
| **Graph Display** | • Show graph in part data screen  
• Show graph data types: Distance, Velocity, Power, Energy, etc. | |
| **Part Data** | • Save part data from multiple welders to one file.  
• Display only most recently welded part data. | • Interval - Save part data (minutes) to file.*  
• Directories to save part data. |
| **Appearance** | • Show window when weld is in progress. | • Locations for: Default Setup Image and Background Image. |
| **Industrial** | • Enable interface to PLCs.  
• Set up High Level Password.  
• Disable outputs to operators.  
• At startup navigate directly to PLC screen. | • Setup Users - Manage User Names.  
• Setup PLCs. |

*NOTE
Data is saved to the PC’s hard drive.

1 NOTE
Password protection prevents editing. It limits those who do not have the password to viewing what is taking place during the weld process.
Basic Setup

A new setup is made when:
- Starting from scratch, when no setups exist;
- Adding a setup to a list (of setups) already created;
- Modifying an existing setup, and saving the modified setup with a new name.

Each of these events begins with the selection of a welder.

1. From the **Select Welder** window on the opening screen, select a welder from the Registered Welders list.

2. A series of windows with progress bars appears to indicate that **iQ Explorer** and the welder are establishing a connection. Once the two are connected, a welder icon appears in the top menu bar as shown in Figure 4-5.

**Figure 4-5** Setup - Registered Welder Icon

![Welder icon indicates a registered welder has been selected.]

Continue with the **Hardware** tab, and go to the next page of this manual.
Basic Setup

3. Click on the **Hardware** tab.

Basic setup continues when information is put into the entry boxes. See Figure 4-6 below.

**Enter/Change Data:**
- A - Welder name.
- C - File name for the image displayed on this tab.
- E - New name for setup file; click Rename.
- F - Date format choice.
- G - Current date and time on the generator.
- H - Booster, horn and fixture identification.

or. . .See **Monitor Data** in the next column.

**Monitor Data:**
- B - View all setup names.
- D - List of key hardware components.

4. After **Hardware** settings have been made, go to **File** and save **Current Setup File (As)**. Then move on to the next page of this manual to **Process Settings**.

**On-line** - When Green: Generator can enable an ultrasound signal.

**Off-line** - When Yellow: A cycle can be run without having ultrasound triggered.

**E-Stop** - When Red. Emergency Stop is active. Generator will not generate an ultrasound signal.
Basic Setup

5. Click on the **Process Settings** tab.

Basic setup continues when information is put into the entry boxes. See Figure 4-7 below.

**Enter/Change Data:**
- A - Welder type.
- B - Initiate Mode choice.
- C - Latch on Bad Part (if Initiate Mode is Manual).
- D - Trigger type and method.
- E - Weld Mode and Method.
- F - Hold method and duration.
- G - Afterburst activate; Delay Time and Duration.

**View Data:**
- Pressure values.
- Amplitude values.
- Secondary Control Values.

or,

- Real time weld data.
- Most recent weld cycle data.

*Figure 4-7 Setup - Process Settings - Press*
Basic Setup

6. Click on the **Process Limits** tab.

   Basic setup continues as the operator chooses which process characteristics (from the **Status** column on the left) will become part of the process record.

   Figure 4-8 shows the drop down menu choices available for each characteristic.

   **NOTE**

   Weld Cycle Data is displayed on the **Process Settings** page (most recent cycle only).
   Additional information is shown on the **Cycle Data** page. (See the next page of this manual.)
Basic Setup

7. Click on the **Cycle Data** tab. This is where you can monitor the accumulated data reported for the weld cycles.

Data displayed on this page results from the choices made by the operator for the **Process Settings** and **Process Limits** pages previously discussed.

Figure 4-9 shows a sample of the **Cycle Data** page.

**Figure 4-9** Setup - Cycle Data
Basic Setup

8. Click on the **Graph** tab. Then, click on the tab, **Graph Setup**. Input choices to set up the graphing function to illustrate a pictorial view of the welding process.

**Make/Change Selections:** (See Figure 4-10 below.)

- **A** - Axis Labels - Choose labels for left, right, and horizontal axes of the graph (from parameters: Distance, Velocity, Power, Energy, Frequency, Force, Press, and Amplitude).
- **B** - Start/Stop - Choose when the graphing should start and stop during the weld cycle.
- **C** - Reference - Select a graph to view as reference (from a folder of previously generated graphs).

---

**Figure 4-10 Setup - Graph Setup**
Basic Setup  

9. Click on the **Graph Display** tab. This is one of two tabs under **Graph**.

See Figure 4-11 for a view of a sample graph.

### NOTE

The values in the upper left portion of the graph show the X and Y values for the cursor position. Cursor movement causes these X, Y values to change accordingly.

![Graph Display](image)

**Figure 4-11** Setup - Graph Display
Basic Setup

10. Click on the **Production** tab. This page provides a graphic analysis of parts produced — the good, the suspect, and the bad. See Figure 4-12 for a sample of this type of graphic feedback.

![Production Display](image_url)

**Figure 4-12** Setup - Production Display
Basic Setup

11. Click on the Utilities tab. Some setup management and diagnostic tools are offered here. See Figure 4-13 for these things.

Make/Change Selections:

A - Part Count - This utility permits part count to be modified using Reset, Preset, and Count Bad Parts.

B - Setup Utilities - Use Setup Control to choose a setup. You can also Erase (a) Setup or Erase All Setups.

C - Part Sampling - This is used to record the amount and kind of parts processed — Lot Size; Sample Size; Exclude (part types); Store (in memory).

D - Test -

WARNING
Clear area near stack before starting the sonics test. Sonics stays active for the length of the test.

Select a duration for testing sonics - 1, 2, or 3 seconds. Then, click the Test button. A window pops up to display the test data result. See Figure 4-14.

E - Off-line - Click the entry box to disable ultrasonics. Click the entry box again to activate ultrasonics.

F - Monitor Encoder Postion - Click this box and the position of the stack (only) will be displayed.

Figure 4-13 Setup - Utilities
Utilities Sonics Test  

The figure below illustrates the kind of data displayed after the TEST button is activated on the Utilities page.

Click EXIT when finished reviewing this data.

NOTE

The values in the upper left portion of the graph show the X and Y values for the cursor position. Cursor movement causes these X, Y values to change accordingly.

Figure 4-14 Setup - Utilities Test Display Sample
Basic Setup

12. Click on the **System** tab.

   A **WARNING** appears immediately indicating that changing hardware settings may affect operation of the generator.

   Click **OKAY** to proceed with hardware modification.

Figure 4-15 Setup - System Warning
System [modifications]  
Hardware fine tuning is offered on the System page. See Figure 4-16 for an overview.

Make/Change Selections:
- **B** - Advanced Hardware - Designed for unique tooling applications. Consult factory prior to adjusting these settings.

- **C** - Serial Communications - Used to configure the serial port as an output for cycle data.

**Output Format** - Determines how cycle data fields are separated.

**Output Mode** - Determines what is sent (All, Good, Bad, etc.)

**Baud Rate** - Speed setting of the serial port in use.

**Flow Control** - A setting of the serial port in use.

**Add LF after CR** - Determines what follows a data record: a carriage return (CR) only, or a CR followed by a line feed (LF).

---

Figure 4-16 Setup - System Overview
Save and Retrieve Setup Files

1. Click **File**. (Refer to Figure 4-17.)
2. From the drop-down menu you can save a setup file (to a file on the PC’s hard drive) in several ways: **Save Current Setup File**, or **Save Current Setup File As**...
3. To retrieve a setup, click on **Select Active Setup** to get a list of setups that are active. Then select a setup from that list.

Save and Retrieve Part Data

1. Click the **Options** icon. (Refer to Figure 4-18, and to Figure 4-1.)
2. Click on the **Part Data** tab.
3. Using the **Main** and **Alternate** categories, you may enter the designated files where part data will be stored.
4. Retrieve part data by locating the files stored in the place (Main) or places (Main and Alternate) so designated above.

Save and Restore Graph Data

1. Click the **Options** icon. (Refer to Figure 4-19, and to Figure 4-1.)
2. Click on the **Graph Data** tab, and then the **Files** tab.
3. Using the **Main** and **Reference** categories, you may enter the designated files where graph data will be stored.
4. Using the **Display** tab you may select the type of data to display in the graph. Another selection to make allows you to display the graph in the part data (Cycle Data) screen.
Using the Help System
This help system is a reference tool to assist in understanding key terms of the ultrasonic welding process. The *iQ Explorer* help function can be accessed using the top menu bar, or by pressing the F1 key as explained below.

**Top Menu Bar**
*Help* is one of the top menu bar items (as shown on right and in Figure 4-1 on Page 25). Clicking on *Help* and then clicking on *iQ Explorer Help* will open the *Help* window.

A *Contents* tab and an *Index* tab are two entry points to the help file information.

*Contents* groups the help file information into these seven categories:
- Hardware;
- Process Control;
- Process Limits;
- Graph;
- Utilities;
- System; and,
- Options.

The *Index* is an alphabetical list of words and phrases.

The illustration at the right illustrates that the term, *Trigger* was found through both *Contents* and the *Index*.

**Using the F1 Key**
The F1 key can be tapped to activate *Help* when:
1) the cursor is positioned in an item that can be edited, such as a text box, drop down list, or check box and,
2) that item is linked to *Help*. 
SECTION 5

Multiple Welder Connections

Introduction .......................................................... 47
Simple Stand-alone Configuration ............................... 47
Unique IP Address .................................................... 48
Connection to Local Area Network ............................ 49
Introduction
There are several methods of networking multiple \textit{iQ} systems. The method you choose depends upon your needs related to access to weld data and controls.

Simple Stand-alone Network

\textbf{Figure 5-1} Simple Stand-alone Network Configuration
Unique IP Address

Each iQ system needs to be programmed with a unique IP address.
See Section 3, Page 20, Changing the Generator’s IP Address.

Once IP addresses have been programmed into each iQ generator, you then need to add this address in the **Tools ➤ Select Welder Type ➤ Machine Interface** box as shown below in Figure 5-2.

![Machine Interface](image)

**Figure 5-2 Adding IP Address**

Add only IP addresses of welders required to connect to your PC.
Connection to Local Area Network (LAN)
Consult your IT department for proper IP address selection.
Each iq system needs to be programmed with a unique IP address.
See Section 3, Page 20, Changing the Generator’s IP

Figure 5-3 Connection to Local Area Network
Connection to LAN  
In this configuration we recommend that each PC coupled with a welding system be programmed to connect to that system only.

See the example in Figure 5-4. Welder A coupled to PC A, and PC A is configured to connect to Welder A IP address.
Program each welder coupled to a PC accordingly: Welder A to PC A, Welder B to PC B, Welder C to PC C, etc.

*iQ Explorer* can be loaded on additional PC’s connected to the LAN. For instance, computers could be located on the desks of the Supervisor, Q.C. Manager, and Production Manager.

This would allow remote access to each welder on the LAN. However, in the production environment we recommend having a second PC (supervisor) connected to a welder for quick analysis and troubleshooting.

Add all welder IP addresses on this second, supervisor PC, as discussed above. Access the Machine Interface window by going to **Tools ➔ Select Welder Type ➔ Machine Interface** box as shown below in Figure 5-5.

![Machine Interface](image)

**Figure 5-5** Adding IP Addresses on Supervisor PC
Once all IP addresses have been added to the supervisor’s PC, from the Main Menu, select **File ➤ Select Welder**. See Figure 5-6.

All connected welders will be displayed.

Multiple welders can be viewed at one time by selecting **Window/Tile Horizontally** or **Vertically**.

Resize the views to fit your screen.

![Figure 5-6 Displaying Connected Welders](image-url)
SECTION 6

Contacting Dukane
This page intentionally left blank
Contacting Dukane

Identify Equipment

When contacting Dukane about a service–related problem, be prepared to give the following information:

• Model number, line voltage and serial number
• Fault/error indicators from the LCD display
• Software version (Press INFO. With pointer at System Information, press ENTER to get this data.)
• Problem description and steps taken to resolve it

Many problems can be solved over the telephone, so it is best to call from a telephone located near the equipment.

Intelligent Assembly Solutions

Mailing Address:  Dukane Ultrasonics
2900 Dukane Drive
St. Charles, IL 60174  USA

Phone:  (630) 797–4900

E-mail:  ussales@dukane.com

Fax:
Main  (630) 797–4949
Service & Parts  (630) 584–0796

Website

The website has information about our products, processes, solutions, and technical data. Downloads are available for many kinds of literature.

Here is the address for the main website:

www.dukane.com/us/

You can locate your local representative at:

www.dukane.com/us/sales/intsales.htm
Appendix A - List of Figures ............................. 59
Appendix B - List of Tables ............................... 60
Appendix C - Regulatory Agency Compliance ............ 61
This page intentionally left blank
### List of Figures

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-1</td>
<td>Select Control Panel from the Start Menu</td>
<td>7</td>
</tr>
<tr>
<td>2-2</td>
<td>Select Display from the Control Panel Window</td>
<td>8</td>
</tr>
<tr>
<td>2-3</td>
<td>Setting Display Colors and Resolution</td>
<td>8</td>
</tr>
<tr>
<td>2-4</td>
<td>Selecting My Computer</td>
<td>10</td>
</tr>
<tr>
<td>2-5</td>
<td>Selecting View System Information</td>
<td>11</td>
</tr>
<tr>
<td>2-6</td>
<td>Checking Operating System Version</td>
<td>11</td>
</tr>
<tr>
<td>2-7</td>
<td>Disable User Account Control I</td>
<td>12</td>
</tr>
<tr>
<td>2-8</td>
<td>Disable User Account Control II</td>
<td>12</td>
</tr>
<tr>
<td>3-1</td>
<td>Installation Start-up Screen</td>
<td>17</td>
</tr>
<tr>
<td>3-2</td>
<td>Network Connections Window</td>
<td>18</td>
</tr>
<tr>
<td>3-3</td>
<td>Local Area Connection Properties</td>
<td>18</td>
</tr>
<tr>
<td>3-4</td>
<td>Internet Protocol (TCP/IP) Properties</td>
<td>19</td>
</tr>
<tr>
<td>3-5</td>
<td>Registered Welders List</td>
<td>19</td>
</tr>
<tr>
<td>3-6</td>
<td>Assign IP Address</td>
<td>20</td>
</tr>
<tr>
<td>3-7</td>
<td>iQ Explorer Start-up Screen</td>
<td>21</td>
</tr>
<tr>
<td>4-1</td>
<td>Top Menu Bar</td>
<td>25</td>
</tr>
<tr>
<td>4-2</td>
<td>Main Menu Icons</td>
<td>26</td>
</tr>
<tr>
<td>4-3</td>
<td>Icon and Function</td>
<td>27</td>
</tr>
<tr>
<td>4-4</td>
<td>Option Tabs</td>
<td>28</td>
</tr>
<tr>
<td>4-5</td>
<td>Setup - Registered Welder Icon</td>
<td>30</td>
</tr>
<tr>
<td>4-6</td>
<td>Setup - Hardware</td>
<td>31</td>
</tr>
<tr>
<td>4-7</td>
<td>Setup - Process Settings - Press</td>
<td>32</td>
</tr>
<tr>
<td>4-8</td>
<td>Setup - Process Limits Drop Down Menu Detail</td>
<td>33</td>
</tr>
<tr>
<td>4-9</td>
<td>Setup - Cycle Data</td>
<td>34</td>
</tr>
<tr>
<td>4-10</td>
<td>Setup - Graph Setup</td>
<td>35</td>
</tr>
<tr>
<td>4-11</td>
<td>Setup - Graph Display</td>
<td>36</td>
</tr>
<tr>
<td>4-12</td>
<td>Setup - Production Display</td>
<td>37</td>
</tr>
<tr>
<td>4-13</td>
<td>Setup - Utilities</td>
<td>38</td>
</tr>
<tr>
<td>4-14</td>
<td>Setup - Utilities Test Display Sample</td>
<td>39</td>
</tr>
<tr>
<td>4-15</td>
<td>Setup - System Warning</td>
<td>40</td>
</tr>
<tr>
<td>4-16</td>
<td>Setup - System Overview</td>
<td>41</td>
</tr>
<tr>
<td>4-17</td>
<td>Save and Retrieve Setup Files</td>
<td>42</td>
</tr>
<tr>
<td>4-18</td>
<td>Save Part Data</td>
<td>42</td>
</tr>
<tr>
<td>4-19</td>
<td>Save Graph Data</td>
<td>42</td>
</tr>
</tbody>
</table>
## Appendix A  Continued

### List of Tables

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-20</td>
<td>Help from Top Menu Bar</td>
<td>43</td>
</tr>
<tr>
<td>4-21</td>
<td>Contents and Index in Help</td>
<td>43</td>
</tr>
<tr>
<td>5-1</td>
<td>Simple Stand-alone Network Configuration</td>
<td>47</td>
</tr>
<tr>
<td>5-2</td>
<td>Adding IP Address</td>
<td>48</td>
</tr>
<tr>
<td>5-3</td>
<td>Connection to Local Area Network</td>
<td>49</td>
</tr>
<tr>
<td>5-4</td>
<td>Example Connection to Local Area Network</td>
<td>50</td>
</tr>
<tr>
<td>5-5</td>
<td>Adding IP Address on Supervisor PC</td>
<td>51</td>
</tr>
<tr>
<td>5-6</td>
<td>Displaying Connected Welders</td>
<td>52</td>
</tr>
</tbody>
</table>

## Appendix B

### List of Tables

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-1</td>
<td>Options Choices for the Operator</td>
<td>29</td>
</tr>
</tbody>
</table>
Regulatory Agency Compliance

FCC
The generator complies with the following Federal Communications Commission regulations.


CE Marking
This mark on your equipment certifies that it meets the requirements of the EU (European Union) concerning interference causing equipment regulations. CE stands for Conformité Européenne (European Conformity). The equipment complies with the following CE requirements.

- The EMC Directive 2004/108/EC for Heavy Industrial —
  EN 61000-6-4: 2001
  EN 55011: 2003
  EN 61000-6-2: 2001
  EN61000–4–2
  EN61000–4–3
  EN61000–4–4
  EN61000–4–5
  EN61000–4–6
  EN61000–4–8
  EN61000–4–11

- The Low Voltage Directive 2006/95/EC.

- The Machinery Directive 2006/42/EC.
  EN 60204: 2006
This page intentionally left blank
This page intentionally left blank
Index

C
Computer Requirements 7

D
Dukane 55
  Contacting 55
  Intelligent Assembly Solutions 55

F
Figures 59

G
General User Information 3

H
Hardware Modification 40
Help System 43
  F1 Key 43

I
Icons 26
  Index 63
  Installation
    Installing 17
    Configuration 18
    Unpacking 17
  Installing
    Configuration
      PC to Single Generator 18
    Intelligent Assembly Solutions 55
  IP Address
    Changing 20
  iQ Explorer 4
    Overview 4
      Process Control 4
    User Interface 4

K
Key Features 4

L
Launching the Software 21
  Change Autoboot 21
  Click Icon 21
List of Figures 59
List of Tables 60
Local Area Network 49

M
Menu Icons 25
Menu Tabs 26
Microsoft .NET Framework 17
Modifications
  Make none 61
Multiple Welder Connections 45
  Adding iP Addresses on Supervisor PC. See Multiple Welder Connections: Standalone Network:
    Unique iP Address
Connection to Local Area Network 49
Example Connection to Local Area Network 50
Standalone Network 47
  Unique iP Address 48

O
Operation
  Icon Detail
    Exit 27
    Keyboard keys 27
    New Setup File. See See Page 27
    Numeric keys 27
    Options 27
    Save Current Item. See Page 27
    Scan network 27
    Select Welder. See Page 27
  Icons 26
    Icon Detail 27
Making an Entry 28
Menu 25
  File 25
  Help 25
  Tools 25
  Window 25
Options 28
  Appearance 29
  Communications 29
  Force 29
  Graph Data 29
  Industrial 29

Continued
O

Part Data 29
Shifts 29
Supervisor 29
Setup 30
Cycle Data 34
Graph 35
  Graph Display 36
Hardware 31
Process Limits 33
Process Settings 32
Production 37
Select Welder 30
System 40
Utilities 38

R

Regulatory Agency Compliance 61
CE Marking 61
FCC 61
Requirements 7
  Computer 7
    CD-ROM Drive 9
    Communication Ports 9
      Ethernet Port 9
    Security Key 9
    USB Port 9
    Hard Disk Space 9
    Memory 7
    Processor 7
    Video Display 7
iQ System 13
Software 10
  .NET Framework 13
  Windows 10

S

Save and Restore Graph Data 42
Save and Retrieve Part Data 42
Save and Retrieve Setup Files 42
Security Key 9, 17
Sonics Test 38
  Test Display 39

T

Tables 60
Touchscreen 4, 28
Dukane ISO

ISO CERTIFICATION
Dukane chose to become ISO 9001:2000 certified in order to demonstrate to our customers our continuing commitment to being a quality vendor. By passing its audit, Dukane can assure you that we have in place a well–defined and systematic approach to quality design, manufacturing, delivery and service. This certificate reinforces Dukane’s status as a quality vendor of technology and products.

To achieve ISO 9001:2000 certification, you must prove to one of the quality system registrar groups that you meet three requirements:
1. Leadership
2. Involvement

The ISO 9001:2000 standard establishes a minimum requirement for these requirements and starts transitioning the company from a traditional inspection–oriented quality system to one based on partnership for continuous improvement. This concept is key in that Dukane no longer focuses on inspection, but on individual processes.

Dukane’s quality management system is based on the following three objectives:
1. Customer oriented quality. The aim is to improve customer satisfaction.
2. Quality is determined by people. The aim is to improve the internal organization and cooperation between staff members.
3. Quality is a continuous improvement. The aim is to continuously improve the internal organization and the competitive position.

ISO 9001:2000 CERTIFIED
Dukane products are manufactured in ISO registered facilities
Please refer to our website at:

www.dukane.com/us/sales/intsales.htm

to locate your local representative.